Bioanalitika gyakorlat

Fehérjekrisztallográfia

A gyakorlat célja:

1. Bemutató: fehérjekristályok előállítása, a kristályosítási kísérletek értékelése

2. Bemutató: röntgendiffrakciós mérés 

3. Fehérjeszerkezet megoldás – modellépítés és finomítás példafeladatok

4. Szerkezetvalidálás
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A felhasznált programok ingyenesen letölthetők:

Honlapjaik (letöltés, dokumentáció …):

CCP4

www.ccp4.ac.uk 
Phenix

https://www.phenix-online.org/ 
Coot (tartalmazza a Phenix és CCP4 programcsomag is)

Magyar nyelvű röntgendiffrakciós jegyzet:

 

http://www.tankonyvtar.hu/hu/tartalom/tamop412A/2011_0025_vegy_1/adatok.html
vagy
http://harmatv.web.elte.hu/Rontgendiffrakcio-jegyzet/Rontgendiffrakc-szerk-vizsg.pdf
Lizozim szerkezetmegoldáshoz letölthető példafájlok és rövid magyarázatok:

http://harmatv.web.elte.hu/Rontgendiffrakcio-jegyzet/Peldafajlok-szerkezetmegoldas/
Eszközök*: 

Kristályosítás:


TTP Labtech Mosquito LCP
Kristálynövekedés monitorozása:
Formulatrix RockImager 2

Diffraktométer: 


Rigaku CrystaLAB Synergy-R
* A műszerfejlesztés za Európai Unió és Magyarország Kormánya támogásával valósult meg ,az Európai Regionális Fejlesztési Alap hozzájárulásával VEKOP-2.3.2-16-2017-00014 és VEKOP-2.3.3-15-2017-00018 pályázatok keretében.
1. Kristályosítás
A kristályosítás első lépése a kristályosítási körülmények előszűrése (sok, nagyon különböző kristályosítási körülmény tesztelése), célja:

· A fehérje kristályosítási fázisdiagramjának feltérképezése (szisztematikus kísérletek pl. PACT screen, PEG-ION screen; Stura footprint screen)
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Az elképzelhető összes körülményből egyenletes mintavétel (ritka mátris screen, pl. JCSG+ screen, Structure screen 1-2, Proplex screen)
Feladat: előzetes szűrés kísérleteinek kiértékelése

1A) Adatok

-fehérjeoldat összetétele:


………………………………

-kísérleti körülmények (ld. függelék):
………………………………

-kristályosító cseppek összetétele:
………………………………

-hőmérséklet:



………………………………
-dátum, kristályosítás: 
…………………..

monitorozás:
………………………

1B) Jelölje meg a kristályosító tálca sematikus rajzán, hogy melyik cseppben mi történt:
0:-  csapadék:1(por) 2(granuláris) 3(amorf) 4(mikrokristályos)  :fázisszeparáció:5  kristály:6(mikro) 7(tű) 8(lap) 9(3D)
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1C) A függelék alapján:
Hány körülményben volt kristályképződés?
…………………………………………………………

Hányféle kristály morfológiát láthatunk?
…………………………………………………………

Azokra az oldatokra, amikben kristályok képződtek, mi jellemző: ………………………………

Nagy ionkoncentrációjú sók típusa („kisózás”)
……………………………………………


pH tartomány
…………………….

Nemionos lecsapószer típusa, + kis koncentrációjú sók(„besózás”):
…………………………… 


pH tartomány
…………………….

Optimalizáláshoz kiválasztott körülmények:


……………………………………………………………………………………………………………
……………………………………………………………………………………………………………
……………………………………………………………………………………………………………
………………………………………………………………………………………………………………….
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2) Adatgyűjtés (röntgendiffrakciós mérés)
A röntgendiffrakciós mérés célja az összes reflexió megmérése a lehető 
legkisebb expozíciós idővel (dózis), emellett a redundancia növelése.

2d sinθ = nλ
2A) Adatok: 

Mérési hőmérséklet: …………………

A fehérjekristály  típusa: …………………


mérete…………………

2B) A tesztmérés alapján 

Várható felbontás:
……………

Kristályminőségi probélmák? ……………………..
Elemi cella paraméterek és kristályrrendszer: ………………………………………………………
2C)A mérési stratégia és mérési idő hogyan változik, ha
változtatjuk a kristályrendszert: …………………………………………………………………..
változtatjuk a várható felbontást: …………………………………………………………………
Az elindított mérés paraméterei:

Runs/frames (különböző elforgatási tartományok/diffrakciós képek száma): ………………
Teljes mérési idő:
………………
Beállítások: …………………………………………

3) Modellépítés
Indítsuk el a Coot programot! 

· A szerkezet beolvasása : File > Open Coordinates
· A térképszámoláshoz szükséges fázisok és amplitúdók File > Auto Open MTZ
Beállítások:

· Display Manager (középső egérgomb görgetése - melyik térkép kontúrszintjét állítja)

· Draw > Cell and Symmetry (A Master Switch Yes-re, -> Apply és OK). kristályban szomszédos molekulák megjelenítése
· Draw >  Go to Atom A kis ablakban tudunk lépegetni a szekvencia szerint.

Az ablak jobb oldalán levő eszköztár alján kattintsunk a nyílra: jelenítsük meg a gombok szöveges feliratait:
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A megjelenített térképek: 

· kék háló 2Fo-Fc típusú differencia térkép, pozitív, ahol van atom a szerkezetben. Javasolt elektronsűrűségi szint 1-1,5σ (egérgörgővel állítható)

· piros (negatív, ahonnan el kell törölnünk atomokat) és zöld (pozitív, ahova be kell raknunk atomokat) háló: Fo-Fc típusú térkép. Javasolt elektronsűrűségi szint 3-3,5σ (egérgörgővel állítható).
Irányítás:

· BAL EGÉRGOMB: forgatás, atomok kiválasztása (atomra kell klikkelni) 

· KÖZÉPSŐ EGÉRGOMB: centrálás másik atomra; görgetés: megjelenített elektronsűrűségi szint
· JOBB EGÉRGOMB: zoom

Általános tanácsok: 

· Sose hagyjunk műveletet befejezetlenül (Accept vagy Cancel)

· Időnként mentsük el a szerkezetet (File > Save coordinates)
A szerkezet javítása a jobb oldali parancsok segítségével történik

· Hiányos oldallánc kiegészítése (ha van elektronsűrűsége): Mutate and Auto Fit (az aminosav kiválasztása egy atomjára klikkeléssel, majd az aminosavnév kiválasztása a listáról)

· Ha a térképen nem látható egy atomcsoport, töröljük el (Delete …)

· Rotamers, vagy Auto Fit Rotamer Oldallánc konformációjának megváltoztatása 

· Flip peptide és Sidechain 180 degree fit: főlánc; Asn, Gln, His átfordítása; a H-kötések alapján!!  
· Real Space Refine Zone Egy vagy több aminosav illesztése az elektronsűrűségi térképhez: 
A fehérrel jelölt illesztett szerkezetrészletet bal egérgombbal megfoghatjuk, és elhúzhatjuk („ráncigálhatjuk” a piros nyíl irányába).
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   Illesztés előtt…
és után.

· Láncszakadás kijavítása: 
-Add Terminal Residue (melyik aminosav előtt vagy után akarunk egy másikat beépíteni)
- az új beépített aminosavat (alanint) helyezzük el a térképnek megfelelően: több kör Real Space 
  Refine Zone, különböző méretű zónákkal (az új aminosav + előtte- és utánalevők)
(- további aminosavak beépítése Add Terminal Residue és Real Space Refine Zone)
-oldalláncok generálása  Mutate and   Auto Fit majd Real Space Refine Zone
3A) Feladat: építsünk be egy-egy fehérjeszakaszt  különböző felbontású térképekbe
A modellépítés menete: a szekvencia mentén lépegetve vizsgáljunk meg minden aminosavat, hogy jól illeszkedik-e a térképbe; és ha kell, javítsuk!
Fájlok: ……………….……………………………….……………………………….………………

Felbontás:
………….

Átépített fehérjeszakasz: ……………….……………………………….………………

Hogyan befolyásolja a térkép minőségét a felbontás: ……….……………………………….………

Keressen olyan aminosavat, aminek nem látszik az oldallánca a térképen! 
Tipikusan milyen típusú aminosavak ezek? .………… .………… .………… .…………
Mi az oka annak, hogy nem látszanak? .………… .………… .………… .……………..
Volt-e olyan aminosav, aminek nem volt egyértelmű a konformációja? .………… .…………
Vizsgáljon meg néhány Asn, Gln vagy His oldalláncot a hidrogénkötések szempontjából! 
.………… .………… .………… .………… .………… .………… .………………………
4. Szerkezetfinomítás, szerkezetvalidálás
Indítsuk el a Phenix programot.  Definiáljunk egy új projektet, a munkakönyvtárunkat megadva. 
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Minden Phenix-ben futtatott program egy sorszámozott alkönyvtárat nyit a munkakönyvtárunkban. Válasszuk ki a jobb oldali menüből: Refinement.

[image: image4.png]Ele Projects Utiities Help
5

© A 2 « # @B £ O
Quit  Preferences  Help Citations Coot  PyMOL KNG  Othertools Askfor help
Actions | Job history |
Projects

s Model tools
Show group: | Al groups z

Experimental phasing

elect & Newproject || €9 Setings Molecular replacement
D Last modified #of jobs | Rfree Model building
& pro1 Jun 07 2017 04:00 ... 5 0.2796 =
reso-fig Mar 23 2017 09:41... 6 01573 (efiluEn=n
pasp-torpeklQ-v Feb 152017 10:23... 99 0.4450 Maps
syl Teril Dec 142016 075... 1 04222
cmk-proba-phe... Jul 05 2016 02:25 ... 10 02832 Ligands
dj1-dipeptic-valid Jun 26 2016 11:06 ... 23 02266 S
pasp-EMBL-H-... Feb0120160107... 9 04726 U
mareco Jan 152016 03:41 ... 12 03337 Comprehensive validation
prob Dec 17 2015 09:1. 02540 | Modelqualty assessment,including real.space »
apsap Nov 16 2015 031, 2 " comelaionand geomety inspection using HoProbiy
masp-dap Nov 122015 09:0... 1
m2-ecotin Oct 06 2015 01:31... 15 02355 POIYGON
cam-sphovalid  ul 01201507118 ... 13 0.2235 B Wleresistarcormperian o vaidation siscenes e e
paap-45-6-2 Jun 16 2015 08:27 ... 3 P08
pcama May 07 2015 08:1... 220 02501 3

Current directory: |jhomejraxis/datajhallglyso-170607a

) [orowee

PHENIX version 1.8.4-1496

Project: prol





4A) Configure fül: 
Adjuk meg a modellépítéskor elmentettt pdb fájl (koordináták) és a kiidnulási mtz fájlt (mért amplitúdók):   Configure > Input files     Add file
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Különböző finomítási stratégiák próbálhatók ki, amelyek a szerkezetet leíró paraméterek számában különböznek 

-hogyan írjuk le a szerkezeten belüli mozgékonyságot/rendezetlenséget: B-faktorok; TLS paraméterek

-ha nem atomi a felbontásunk, a molekulageometriai kényszerfeltételekre van szükség a molekulageometria megtartásához (kötéshosszak, kötésszögek, királis és síkalkatú csoportok)
A finomítás során a mért és a modellből számolt amplitúdók eltérését (pl. Σreflexiók(Fobs-Fcalc)2 )
és a geometriának az ideális geometriától való eltérését (pl. Σkötések(daktuális-dideális)2 ) különbözőképpen súlyozva minimalizáljuk.

4A) Refinement settings fülben állítsuk be:

     ( XYZ coordinates (3 paraméter/atom)
     ( Individual B-factors (1 paraméter/atom)
     Refinement cycles: 2

    Optimize 

RUN: indítsuk el a finomítást



A finomítás után automatikusan megtörténik a validálás is.
· Run status; Results fül: illeszkedés a mért adatokhoz: R-faktor
· Modell-geometria (Molprobity) az ideális geometriától jelentősen eltérő kötéshosszak, kötésszögek, planáris és királis csoportok konfigurációja, torziósszögek (Ramachandran térkép és oldalláncok) 

·  Kedvezőtlen másodlagos kölcsönhatások (clash) – szintén a Molprobity fülnél található.

· A kiugróan nagy B-faktorú aminosavak felsorolása az Atomic properties fülnél található.

· A Model and data fülnél indítsuk el a coot programot (Open in Coot) – itt a modell problémás régiói jól láthatóan meg lesznek jelölve a Coot-ban. A validálás táblázataiban a felsorolt problémás aminosavakra kattintva a Coot automatikusan ezekre ráközelít.












(Megjegyzés: a validálás külön is lefuttatható, és szerveren is elérhető: Molprobity.) 
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· Nagyon jó áttekintő grafikon található a Real-space correlation fül alatt (Multi-criterion plot),: elektronsűrűség korreláció; B-faktorok; főlánc (Ramachandran térkép) vagy oldallánc konformáció,  kedvezőtlen térbeli közelség. 
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A validálás eredményei alapján a szerkezetben melyik régiókat kell még javítanunk? 

Vizsgáljuk meg a rossz geometriával rendelkező részeket a szerkezetben: lehetne-e másképpen a térképhez illeszteni a modellnek ezeket a részeit, úgy, hogy a geometriai torzulást kiküszöböljük? 

Vannak-e olyan részek, ahol nagyon kis elektronsűrűség, vagy ’szakadozott’, zajos? – Arról, hogy az ilyen helyeken talált elektronsűrűség zaj-e úgy győződhetünk meg, hogy a szerkezetből eltöröljük ezeket az atomcsoportokat, majd egy finomítási ciklus után megvizsgáljuk, hogy újra megjelennek-e az elektronsűrűségi térképen.  

4B) Validálás eredményei
Hogyan változott az R és Rfree a finomítás során? előtte: ………………..utána:………………

A  szerkezetben melyik régiókat kell még javítanunk? 

……………….……………….……………….……………….……………….……………….
Vizsgálja meg a rossz geometriával rendelkező részeket a szerkezetben: lehetne-e másképpen a térképhez illeszteni a modellnek ezeket a részeit, úgy, hogy a geometriai torzulást kiküszöböljük?
R-faktor:�Makromolekuláknál túlillesztés veszélye miatt szabad R-faktor is


	R= (reflexiók (Fobs - Fcalc ( / (reflexiók Fobs
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